
GD-80 series and V4 series Monitouch can be replaced with V6 series Monitouch.

Although replacement is possible, performance and function are not always 100% compatible and

there are restrictions in replacement and also there are functions that cannot be realized due to

replacement.

This brochure deals with the items to be taken into consideration when replacing currently used

Monitouch with V6 series from the standpoint of hardware and software respectively.

Please note that the brochure only describes the contents related to replacement and does not

cover the functions and specifications of GD-80 series, V4 series and V6 series.  Refer to GD-80

USER'S MANUAL, V Series Reference Manual and other related manuals for details of the

functions and specifications of Monitouch of these series.

Hakko Electronics Co., Ltd

About File Conversion
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1CONSIDERATIONS ON HARDWARE

When you replace the Monitouch with its succeeding model, there are always several items that differ

between the present and new models due to improvements in hardware and software specifications.

This section deals with such differences and availability of countermeasures for individual models.

GD-80 Series -> V6 Series

 GD-80T/E

GD-80T/E

Effective 
display area

V6 Countermeasures

GD-80T
 9.8"

GD-80EH/E0
 8.9"

V610T/V610C
 10.4"

V608C
 7.7"

V609E
 8.9"

Panel cutout 
dimensions
(Unit: mm)

GD-80T
317 W x 229 H

GD-80EH/E0
277 W x 192 H

V610T/V610C
289 W x 216.2 H

V608C
220.5 W x 165.5 H

V609E
277 W x 192 H

Resolution 
for touch switches

GD-80T
20 W x 10 H switches
(Matrix type)

GD-80EH/E0
20 W x 10 H switches
(Matrix type)

V610T/V610C
 1024 W x 1024 H
 (Analog type)
 40 W x 24 H switches
 (Matrix type)

V609E
40 W x 24 H switches
(Matrix type)

Model
Item

Compatible model GD-80T
(TFT color)

GD-80EH
 (High-intensity EL)
GD-80E0(EL)

V610T
(TFT color)
V610C
(STN color)
V608C
(STN color)

V609E
 (High-intensity EL)

Pay attention to the display device.

Display size is somewhat enlarged.

Use panel adapter "PAD-V610" 
(product of Hakko Electronics: option).

Use panel adapter "PAD-V608"
 (product of Hakko Electronics: option).

Resolution for 
display

GD-80T
640 W x 400 H dots

GD-80EH/E0
640 W x 400 H dots

V610T/V610C/V608C
640 W x 480 H dots

V609E
640 W x 400 H dots

Expands by 80 dots in the vertical 
direction.

Display size is somewhat reduced.

V608C does not have matrix type.
It has only analog type
(1024 W x 1024 H).

Use high-intensity EL also to 
replace GD-80E0 (EL).

CONSIDERATIONS ON HARDWARE



2 CONSIDERATIONS ON HARDWARE

(Only for GD-80xxxM)
Available

Printer port

Memory card 
function

"GD-MREC02" 
cannot be used.

Communication
cable

External I/O 
terminals

With RUN, STOP 
and BZ terminals

RUN, STOP and BZ 
terminals are not 
available.

None

RS-422 terminal (Only for GD-80xxx0)
Available

Not available

D-sub 15-pin 
connector
(For direct 
connection to 
Mitsubishi A/Q/FX 
CPU)

To use "MB-CPU" 
(cable for D-sub 15-pin connector)

1) V610T/C
Use 15-pin/25-pin conversion 
cable "CAB-001" + "MB-CPU"

2) V609E
Use terminal converter
"TC609" + "MB-CPU".

To connect to CPU using 
D-sub 25-pin connector
Use D-sub 25-pin connector cable, 
"MB-CPUQ".

Use terminal converter "TC485" or 
"TC609" (only for V609E)
 (product of Hakko Electronics: both 
options).

Not available

Direct connection to 
CPU is possible 
using standard D-
sub 25-pin connector

Screen data 
transfer cable

Connected to D-sub 
25-pin connector.
"GD-CP"
"GD-CPV"

Connected to modular 
jack.
Accordingly, the cable 
prepared for GD-80 
cannot be used.

Use screen data transfer cable for 
V6, "V6-CP" 
(product of Hakko Electronics).

Connected to D-sub 
25-pin connector.

Connected to D-sub 
25-pin connector.
Accordingly, the cable 
prepared for GD-80 
can be used.

Centronics 14-pin 
connector
Standard printer 
cable for PC-9801 is 
used.

Half-pitch 36-pin 
connector
Accordingly, the 
printer cable prepared 
for GD-80 cannot be 
used.

Use printer cable for V6, "V6-PT" 
(product of Hakko Electronics).

Bar code reader 
connection

(Only for GD-80xx2x)
D-sub 9-pin 
connector is 
available.

Standard specification 
provides the 
connector for bar 
code reader.
Connected to the 
modular jack.

Use bar code reader cable for V6, 
"V6-BCD" 
(product of Hakko Electronics).

(Only for GD-
80xx2x)
Compatible by using 
recorder, 
"GD-MREC02".

Use card recorder for V6, "CREC" 
(product of Hakko Electronics).

Storing screen 
data in memory 
card

Can be stored using 
recorder, 
"GD-MREC01".

"GD-MREC01" 
cannot be used.

Use card recorder for V6, "CREC" 
(product of Hakko Electronics).
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Protective 
screen filter

GD-80T
[GD-GS80T]

GD-80EH/E0
[GD-GS80E]

V610T/V610C
[V610-GS]
V608C
[V608-GS]

V609E
[GD-GS80E]

GD-80T
[GD-WP80T]

GD-80EH/E0
[GD-WP80E]

V609E
[GD-WP80E]
(Compatible to IP64)

Memory card
"REC-MCARD"

FLASH ROM

SRAM

Analog RGB 
output

(Only for
 GD-80TAxxx)
Compatible

Not compatible (For details, please contact us.)

Cannot be used 
directly.

Store the memory card data using 
GD-SFT80WE then read and 
convert the data using V-SFTE.

Cannot be used 
directly.

If the memory card was used to 
store the screen data backup.
 
Store the memory card data using 
GD-SFT80WE then read and 
convert the data using V-SFTE.

If the memory card function was 
used.

Change the applicable model 
name written to the memory card 
using "M-CARD SFTE" 
(to be purchased separately).

Water-proof 
screen filter

V610T/V610C/V608C
(Not necessary
Standard specification 
is compatible to IP65.)

CONSIDERATIONS ON HARDWARE
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 GD-80S

GD-80S

Effective
 display area

V6 Countermeasures

GD-80SE/SL
4.7"

V606/V606i
5.7"

Panel cutout
 dimensions
(Unit: mm)

GD-80SE/SL
158.5 W x 122.5 H

V606/V606i
174 W x 131 H

Model
Item

GD-80SE
(High-intensity EL)

GD-80SL
(White mode)

V606C/M
(STN color/monochrome)
V606iT/iC/iM
(TFT color/STN color
/monochrome)

V606/V606i
1024 W x 1024 H
(Analog type)
20 W x 12 H switches
(Matrix type)

Connected to D-sub 
9-pin connector.
[GD-CPS]
[GD-CPSV]

Connected to modular 
jack.  Accordingly, the 
cable prepared for 
GD-80S cannot be used.

Memory card
 "REC-MCARD"

FLASH ROM/SRAM Cannot be used directly.

Protective screen
filter

[GD-GS80S] [V606-GS]

* If V606/V606i is used by expanding panel cutout size.

Resolution for 
display (dot)

320 W x 240 H 320 W x 240 H

Communication 
cable

Pin No.

1

2

3

7

9

10

12

13

14

17

Signal Name

FG

SD

RD

SG

+5V

0V

+SD

-SD

+RS

-RS

Description

4

5

6

8

11

15

16

20

21

22

23

RS

CS

18

19

-CS

+CS

24

25

+RD

-RD

V606/V606i Side (D-sub 25-pin)
Pin No.

1

2

3

7

9

10

12

13

14

Signal Name

FG

RD

SD

SG

COM

+RD

+SD

-SD

RUN

Description

4

5

6

8

11

15

CS

RS

GD-80S Side (D-sub 15-pin)

-RD

BZ

(None)

(None)

(None)

*2

Frame ground

RS-232C receive data

RS-232C send data

RS-232C clear to send RS

RS-232C request to send CS

Signal ground

Output common

RS-422 receive data

RS-422 receive data

RS-422 send data

RS-422 send data

RUN signal

Buzzer signal

Frame ground

RS-232C receive data

RS-232C send data

RS-232C request to send RS

RS-232C clear to send CS

Not used

Signal ground

Not used

Reserved

Reserved

Not used

RS-422 send data (+)

RS-422 send data (-)

RS-422 RS send data (+)

Not used

Not used

RS-422 RS send data (-)

RS-422 CS receive data (-)

RS-422 CS receive data (+)

Not used

Not used

Not used

Not used

RS-422 received data (+)

RS-422 received data (-)

The communication cable used for GD-80SE/SL 
has a D-sub 15-pin connector at the 80 side and 
cannot be used for V606/V606i (D-sub 25-pin 
connector) directly.
Differences in pin arrangement is shown in the 
illustration in the right.
Prepare the conversion cable referring to the pin 
arrangement chart.

Compatible 
model

If panel cutout is enlarged, 
V606/V606i can be used.

 Models compatible to GD-80SE 
(high-intensity EL) are not 
available.  Monochrome LCD type 
(V606M/V606iM) is recommended.
 
Note: V606M is white mode and 
V606iM is blue mode.

Resolution for 
touch switches

10 W x 6 H switches
(Matrix type)

Screen data 
transfer cable

Use screen data transfer cable for 
V6, "V6-CP" 
(product of Hakko Electronics).

Connected to D-sub 
15-pin connector.

Connected to D-sub 
25-pin connector.

Use the cable different from the one 
used for GD-80S
 *2 For details, see below.

Storing screen 
data in memory 

Can be stored 
using recorder, 
"GD-MREC01".

"GD-MREC01" 
cannot be used.

Use card recorder for V6, "CREC" 
(product of Hakko Electronics).

Store the memory card data using 
GD-SFT80WE then read and 
convert the data using V-SFTE.

CONSIDERATIONS ON HARDWARE
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 GD-81S

GD-81S

Effective display
 area

V6 Countermeasures

5.7" 5.7"

Panel cutout 
dimensions
(Unit: mm)

199 W x 147 H 174 W x 131 H

Resolution for 
touch switches

10 W x 6 H switches
(Matrix type)

Connected to D-sub 
25-pin connector.
[GD-CP]
[GD-CPV]

Printer port

Memory card
"REC-MCARD"

FLASH ROM/SRAM

Protective screen 
filter

[GD-GS81S] [V606-GS]

Model
Item

Compatible model GD-81SC
(STN color)

GD-81SW
(White mode)

GD-81SB
(Blue mode)

GD-81SH
(Semi-transparent 
yellow)

V606iT
(TFT color)

V606C/V606iC
(STN color)

V606M
(White mode)

V606iM
(Blue mode)

Resolution for 
display

320 W x 240 H dots 320 W x 240 H dots

Communication 
cable

Case colors are gray for V606 and 
black for V606i.
 (Case color can be specified for 
GD-81S.)

Models compatible to GD-
81SH(Semi-transparent yellow) are 
not available.
Monochrome LCD type 
(V606M/V606iM) is recommended.

Use panel adapter "PAD-V606" 
(product of Hakko Electronics: 
option).

1024 W x 1024 H
(Analog type)
20 W x 12 H switches
(Matrix type)

Screen data 
transfer cable

Connected to modular 
jack.
Accordingly, the cable 
prepared for GD-81S 
cannot be used.

Use screen data transfer cable for 
V6, "V6-CP" 
(product of Hakko Electronics).

Connected to D-sub 
25-pin connector.

Connected to D-sub 
25-pin connector.
Accordingly, the cable 
prepared for GD-81S 
can be used.

Centronics 14-pin 
connector
Standard printer 
cable for PC-9801 is 
used.

Half-pitch 36-pin 
connector
Accordingly, the 
printer cable prepared 
for GD-81S cannot be 
used.

Use printer cable for V6, "V6-PT" 
(product of Hakko Electronics).

Storing screen 
data in memory 
card

Can be stored using 
recorder, 
"GD-MREC01".

"GD-MREC01" 
cannot be used.

Use card recorder for V6, "CREC" 
(product of Hakko Electronics).

Cannot be
 used directly.

Store the memory card data using 
GD-SFT80 or GD-SFT80W then 
read and convert the data using V-
SFT.

CONSIDERATIONS ON HARDWARE
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V4 Series -> V6 Series

 V4

V4

Effective display 
area

V6 Countermeasures

10.4" V610T/C
10.4"

V608C
7.7"

Panel cutout 
dimensions
(Unit: mm)

317 W x 229 H V610T/C
289 W x 216.2 H

V608C
220.5 W x 165.5 H

40 (W) x 24 (H)
 switches
(Matrix type)

V610T/C
1024 (W) x 1024 (H)
(Analog type)
40 (W) x 24 (H) 
(Matrix type)

V608C
1024 (W) x 1024 (H)
(Analog type)

External I/O 
terminals

 None

RS-422 terminal Available Not available

Model
Item

Compatible model V4T
(TFT color)

V4C
(STN color)

V4W
(White mode)

V4B
(Blue mode)

V4H
(Semi-transparent 
yellow)

V610T
(TFT color)

V610C/V608C
(STN color)

Resolution for 
display

640 W x 480 H (dots) 640 W x 480 H (dots)

Use panel adapter "PAD-V610" 
(product of Hakko Electronics: 
option).

Use panel adapter "PAD-V608" 
(product of Hakko Electronics: 
option).

Resolution for 
touch switches

With RUN, STOP 
and BZ terminals

RUN, STOP and BZ 
terminals are not 
available.

 Use terminal converter "TC485" 
(product of Hakko Electronics: 
option).

Screen data 
transfer cable

Connected to D-sub 
25-pin connector.
[GD-CP]
[GD-CPV]

Connected to modular 
jack.
Accordingly, the cable 
prepared for V4 
cannot be used.

Use screen data transfer cable for 
V6, "V6-CP" 
(product of Hakko Electronics).

Communication 
cable

Connected to D-sub 
25-pin connector.

Connected to D-sub 
25-pin connector.
Accordingly, the 
cable prepared for V4 
can be used.

CONSIDERATIONS ON HARDWARE
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Bar code reader 
connection

Memory card 
function

Memory card
"REC-MCARD"

FLASH ROM Read and convert the data using 
V-SFT.

SRAM Cannot be used 
directly.

Protective screen 
filter

[V4-GS] V610T/C
[V610-GS]

V608C
[V608-GS]

Analog RGB 
output

(Only for V4T2)
Compatible

Not compatible  (For details, please contact us.)

External I/O (Only for V4Tx3)

Use card recorder for V6, "CREC"
 (product of Hakko Electronics).

"GD-MREC02"  
cannot be used.

Only for V610x2
Compatible using 
internal memory 
card interface.

Printer port  Use printer cable for V6, "V6-PT"
 (product of Hakko Electronics).

Centronics 14-pin 
connector
Standard printer 
cable for PC-9801 is 
used.

Half-pitch 36-pin 
connector
Accordingly, the 
printer cable 
prepared for V4 
cannot be used.

(Only for 
V4xx2/V4xx4/V4xx5)
D-sub 9-pin connector 
is available.

Standard 
specification 
provides the 
connector for bar 
code reader.

Use bar code reader cable for V6, 
"V6-BCD"
 (product of Hakko Electronics).

Use card recorder for V6, "CREC" 
(product of Hakko Electronics).

Storing screen 
data in memory 
card

Can be stored using 
recorder, 
"GD-MREC01".

"GD-MREC01"
 cannot be used.

Cannot be used 
directly.

If the memory card was used to 
store the screen data backup.

Read and convert the data using 
V-SFT.
 
If the memory card function was 
used.
 Memory card can be used for V6 
directly if the format is identical.

Standard specification 
provides the connector 
for external I/O.
"E-I/O" (product of 
Hakko Electronics: 
option) or "V-I/O" 
(product of Hakko 
Electronics: option) is 
separately necessary.

Only for 
V4xx5/V4xx6 
Compatible by using 
recorder, 
"GD-MREC02".

Only for 
V4xx2/V4xx4
Compatible using 
internal memory 
card interface.

CONSIDERATIONS ON HARDWARE
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V4S

Effective display 
area

V6 Countermeasures

5.7" 5.7"

199 W x 147 H 174 W x 131 H

10 W x 6 H switches
(Matrix type)

1024 W x 1024 H
(Analog type)
20 W x 12 H switches
(Matrix type)

Connected to D-sub 
25-pin connector.
[GD-CP], [GD-CPV]

Printer port

Memory card
"REC-MCARD"

FLASH ROM/SRAM

Protective screen 
filter

[V4S-GS] [V606-GS]

Model
Item

Compatible model V4SC
(STN color)

V4SW
(White mode)

V4SB
(Blue mode)

V606iT(TFT color)
V606C/V606iC
(STN color)

V606M
(White mode)

V606iM
(Blue mode)

320 W x 240 H (dots) 320 W x 240 H (dots)

Case colors are gray for V606 and 
black for V606i.
 (Case color can be specified for 
V4.)

Panel cutout 
dimensions
(Unit: mm)

Use panel adapter "PAD-V660" 
(product of Hakko Electronics: 
option).

Resolution for 
display

Resolution for 
touch switches

Screen data 
transfer cable

Connected to modular 
jack.
Accordingly, the cable 
prepared for V4S 
cannot be used.

Use screen data transfer cable for 
V6, "V6-CP" 
(product of Hakko Electronics).

Communication 
cable

Connected to D-sub 
25-pin connector.

Connected to D-sub 
25-pin connector.
Accordingly, the cable 
prepared for V4S can 
be used.

Centronics 14-pin 
connector
Standard printer 
cable for PC-9801 is 
used.

Half-pitch 36-pin 
connector
Accordingly, the printer 
cable prepared for V4S 
cannot be used.

Use printer cable for V6, "V6-PT" 
(product of Hakko Electronics).

Bar code reader 
connection

(Only for V4Sxx2)
D-sub 9-pin 
connector is 
available.

Standard 
specification provides 
the connector for bar 
code reader.
Connected to the 
modular jack.

Use bar code reader cable for V6, 
"V6-BCD" 
(product of Hakko Electronics).

Storing screen 
data in memory 
card

Can be stored 
using recorder, 
"GD-MREC01".

"GD-MREC01" cannot 
be used.

Use card recorder for V6, "CREC" 
(product of Hakko Electronics).

Cannot be used 
directly.

Read and convert the data using 
V-SFTE.

 V4S

CONSIDERATIONS ON HARDWARE
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2CONSIDERATIONS ON SOFTWARE

Procedure for converting the screen data files also largely differs depending on the models.

This section deals with conversion procedure and items that require special attention in details, for cases

"GD-80 series -> V6 series" and "V4 series -> V6 series".

GD-80 Series -> V6 Series

 Converting the Screen Data Files
For the conversion of the screen data files into the V6 series compatible files, always use V-SFTE.

1. Click the [Open] icon, or select [Open] from the [File] menu.

2. The [Open a screen data file.] dialog is displayed.

Change the [File of type] to [*.80].

or

3. Specify the GD-80 screen data file to convert, and click [Open].

4. The [Edit Model] dialog is displayed.

Select the model to be used after conversion, then click [OK].

CONSIDERATIONS ON SOFTWARE
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V610
640 x 480

V608
640 x 480

V606/606i
320 x 240

Model

Resolution W x H

(Dots)

GD-80T 640 x 400

GD-80S 320 x 240

: No problems on resolution
: No problems on resolution, but dimensions differ.

GD-81S 320 x 240

GD-80E 640 x 400

V609E
640 x 400

Size change 
necessary

Size change 
necessary

 Differences in screen size

Depending on the original and conversion target models, resolution of the screen may differ as shown in the

table below.

 Adjusting the size

When converting the screen data of GD-80T into the analog switch type display for V610, enlarge the screen

image after grouping the entire screen image as explained below.  This allows the converted screen image to

fit the new screen size in simple operation.

1. Cancel the ON grid ([Display] -> [ON Grind]) and switch grid ([Display] -> [Display Environment] -> [Grid]

menu -> [  Snap on Switch Grids]) using the editor.  Select and group all items on the screen.

5. The editor displays the screen data converted for V6 series.
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 Cautions on conversion
Conversion contents are largely classified into four categories when converting the GD-80E screen data into

the data for V609E.

GD-80E compatible functions implemented by V-SFTE Ver.1.2.19.0

GD-80E compatible functions implemented by V-SFTE Ver.1.2.18.0

Data converted as GD-80 compatible data

Functions that cannot be converted as GD-80 compatible data (as of V-SFTE Ver. 1.2.19.0)

Described below are cautionary items to be taken into consideration for each conversion content.

 GD-80 Compatible Functions Implemented by Ver. 1.2.19.0

With the introduction of V-SFTE Ver. 1.2.19.0, several GD-80 compatible functions are added.  Conversion of

CONSIDERATIONS ON SOFTWARE

GD-80E V-SFTE    Ver. 1.2.19.0Model
Item

Overlap • Normal
  Registered in DIV0 and 
  other functions are reg-
  istered in other DIV 
  numbers.  (May be used 
  as multi-overlap)

<Previous version>
Only registered in the screen as normal overlap.
To use the normal overlap as multi-overlap, it is necessary 
to register this normal overlap to [Multi-Overlap Edit].

<1.2.19.0>
Possible
With the normal overlap converted on the screen left as is, 
the overlap is copied to the [Multi-overlap Edit] of the 
same number as the screen number.

(Conversion of the screen for which only normal overlap is 
registered in DIV0 is processed in the same manner as 
before.  See P3-14.)

2. Drag the handle at the lower right corner

of the grouped item to fit the image size

to the V6 screen size.

* To change the screen image for V610

matrix switch type, the procedure

above cannot be used since the switch

grid positions may be offset.

Expanding by

80 dots in the

Y direction
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Switches/Lamps When a switch/lamp 
having the same OFF 
color as the background 
color is set, the objective 
displayed in the OFF 
color is invisible.

Switches In the state two switches 
overlap with each other, 
the switch assigned a 
larger number (or a 
larger DIV No.) responds 
when the switch overlap-
ping area is pressed.

Switch (bottom)

Lamp (top)

GD-80E V-SFTE    Ver. 1.2.19.0Model
Item

Example)

On GD-80

At OFF, the lamp is invisible.

Switch (bottom)

Lamp (top)Example)
On V6

Lamp overwrites switch.

Switch (bottom)

Lamp (top)
On V6

At OFF, the lamp is invisible.

No. 1

No. 0

No. 1

If you press this area,

No. 0

No. 1

Switch No. 1 responds.

No. 0

Switch No. 0 responds.

On GD-80

No. 0

No. 1

No. 0

No. 1

If you press this area,

On V6

No. 0

No. 1

If you press this area,

On V6 No. 0

No. 1

Switch No. 1 responds.

After the conversion, the switch assigned a larger number 
(or a larger DIV No.) comes top over the one assigned a 
smaller number (or a smaller DIV No.) on the editor.

<Previous Version>
Pressing the overlapping area causes the switch set 
bottom to respond.

<V1.2.19.0>
Possible
By checking [Make the upward switch effective when 
switches are overlapped] in the [GD80 Compatible] tab 
window of [Others]

<Previous Version>
On the editor or MONITOUCH, display is always given i
n the state the switch/lamp set on top overwrites the one 
set at bottom.

<V1.2.19.0>
Possible
By checking [Not paint when OFF color of switch/lamp is 
the same as background color] in the [GD80 Compatible] 
tab window of [Others]

Although overwriting occurs on the editor as the previous 
version, display on V6 is given in the same manner as 
GD-80.

CONSIDERATIONS ON SOFTWARE
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<Previous Version>
If an unregistered numeric data block exists within switch-
ing over target block range specified by [Start No.] and 
[End No.], block switching over processing is suspended 
at an unregistered block.

<V1.2.19.0>
Possible
By checking [Skip the tenkey block which does not exist 
when operating + or - block switch] in the [GD80 
Compatible] tab window of [Others]

<Previous Version>
If a message overflows the switch/lamp area, overflowing 
characters are continuously displayed in the second line.

<V1.2.19.0>
Possible
By checking [Making messages same as in GD80 when 
[Action area] is [Switch/Lamp]] in the [GD80 Compatible] 
tab window of [Others]

Relay mode /
Page mode /
Direct mode
([Action: Switch/
Lamp])

If a message overflows 
the switch/lamp area, 
overflowing characters 
are not displayed.

Switching over of 
numeric data 
blocks (Numeric 
key mode, [Action: 
Plus block/Minus 
block] switch)

Switching over is pro-
cessed even when un-
registered numeric data 
blocks exist between 
[Start No.] and [End No.] 
of switching over target 
[Block No.].

Switch

GD-80E V-SFTE    Ver. 1.2.19.0Model
Item

Example)

Actually, characters “P...U” 
continue after “O.” 

On V6

ABCDEFGHIJKLMNO

ABCDEFGHIJKLMNOP
QRSTU

Message is displayed 
in multiple lines.

ABCDEFGHIJKLMNO

Example)

No. 0

No. 4

Unregistered

All blocks, including 
unregistered blocks 
are switched over.

Example)

No. 0 No. 4

Unregistered block

Switching over is impossible for blocks that appear 
after the unregistered block.

No. 1 No. 2 No. 3

Switching over possible Switching over impossible

No. 0 No. 4

Unregistered blocks are skipped.

No. 1 No. 3
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<Previous Version>
For the display of the graphic relay on an overlap, the reg-
istered graphic is displayed in reference to the datum 
point of the overlap.

<V1.2.19.0>
Possible
By checking [Regard the original of graphic relay on an 
overlap as the origin of a screen] in the [GD80 
Compatible] tab window of [Others]

Switching the 
numeric keypad 
to HEX data entry 
keys

The [-/+] key in the nu-
meric keypad is automat-
ically changed to the 
HEX entry selection key.

<Previous Version>
The [-/+] key in the numeric keypad is not changed to the 
HEX entry selection key automatically.  It is necessary to 
set the HEX entry selection key ([Function: Graphic 
Library]) for the individual appearances.

<V1.2.19.0>
Possible
The [Change GD80 Compatible HEX Key] item is added 
to [Function].
Identical operation as with GD-80 (as shown in the left)

Graphic relay 
mode on overlap

When a graphic relay is 
set on an overlap, the 
registered graphic is 
displayed in reference to 
the datum point of the 
screen.

GD-80E V-SFTE    Ver. 1.2.19.0Model
Item

Example)

For HEX entry

Example) Graphic library

7 8 9

4 5 6

1 2 3 CL

0 . +/- CR

7 8 9

4 5 6

1 2 3 CL

0 . A-F CR

Changed to the HEX 
entry selection key.

Screen

Overlap

Screen

OverlapDatum point

Datum point

Screen

OverlapDatum point
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Data sampling The count data is dis-
played in the leftmost 
column.

<Previous Version>
The count data is not displayed, but the leftmost column 
is left blank.

<V1.2.19.0>
Possible
By converting data [No. 15] on [Sampling Display Area] 
automatically to count display area.
[Sample Count] item is added to the [Data [15]] dialog.

* The count position setting [C], necessary for printing the 
  sampling data, is automatically converted to [15] for printing 
  the count data.  (In message editing)

Screen library Example)
Screen library is set in 
the following manner

<Previous Version>
Not converted as the screen library

<V1.2.19.0>
Possible
Screen library is converted as shown below.

GD-80E V-SFTE    Ver. 1.2.19.0Model
Item

Screen No. 4 (DIV 3)

000
001
002
003
004

55
64
33
48
56

113
119
106
121
107

3345
3450
3250
2956
2246

55
64
33
48
56

113
119
106
121
107

3345
3450
3250
2956
2246

Screen No. 7

ERROR DISPLAY

Screen No. 4 (DIV 3)

Screen No. 7

ERROR DISPLAY

Screen No. 4 (DIV 3)

SLIB

Screen No. 7

ERROR DISPLAY
SLIB

Screen library No. 454 (DIV 3)

OFF

How to calculate the screen library No. after conversion:

Screen calls are set on the individual screens 
(source screen of GD-80 and target screen).

In the screen library, 
items on the source screen 
are copied.

Screen library No. = Original screen No. + DIV No. x 150
= 4 + 3 x 150
= 454

Screen library
Div 2
    Screen library
Div. No. 3
Screen No. 4
    Graphic
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GD-80E

Continuous buzzer 
sound

V-SFTE    Ver. 1.2.18.0

The buzzer keeps sound-
ing while read area n, bit 
10 is ON.

Possible
By checking [Use continuous buzzer sound] in the 
[GD80 Compatible] tab window of [Others]

Model
Item

In the case of overflow, 
lower digits are displayed.

Example: D100 = D1234
4-digit display: 1234
2-digit display: 34

Numerical data 
display

Possible
By checking [Num. Data Display: display the significant 
figures when overflowing] in the [GD80 Compatible] tab 
window of [Others]

With check mark : Same display mode as with GD-80.
4-digit display: 1234
2-digit display: 34

Without check mark : Display is given in the manner 
shown below.

4-digit display: 1234
2-digit display: --

Overlap bit 
command

Overlap is displayed 
while read area “n+1”, bit 
12 is ON.
(The overlap is kept dis-
played even if the display 
is changed.)

Possible
By checking [Display an overlap be level of ON bit] in the 
[GD80 Compatible] tab window of [Others]

With check mark : Same operation as GD-80.
Without check mark : Bit 12 setting is recognized at the 

signal edge.
(Even if the bit is set ON, the overlap is cleared when the 
display is changed.)

--> Continued
(Screen library)

If [Graphic] is checked for screen library at GD-80, the graphics is moved to screen 
library at V6.  However, if the same screen library is used with [Graphic] checked and 
unchecked at GD-80, the setting for the screen assigned a larger screen number has 
priority.

Screen No. 4 (DIV 3)

Screen No. 7

ERROR DISPLAY

A B C D E

Pre NXT

Screen No. 10

A B C D E

Pre NXT

1234
1234
1234

1234
1234
1234

1234
1234
1234

1234
1234
1234

Example) GD-80 V6
Screen library No. 454 (DIV 3)

Screen No. 7

ERROR DISPLAY

A B C D E

Pre NXT

Screen No. 10

A B C D E

Pre NXT

1234
1234
1234

1234
1234
1234

1234
1234
1234

1234
1234
1234

A B C D E

Pre NXT

OFF

SLIB

SLIB

The setting at the screen having a larger screen number at GD-80 has priority.

The status of the screen 
having a smaller screen 
number at GD-80 differs 
that of the screen display-
ed on GD-80.

Screen library
    Graphic

Screen library
    Graphic

 GD-80 Compatible Functions Implemented by Ver. 1.2.18.0
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GD-80E

Character entry 
mode

V-SFTE    Ver. 1.2.18.0

Continuous entry of 
characters is permitted 
even after pressing the 
[ENT] key.

Possible
By checking [Clear characters when a cursor is on the 
first character in Character Entry Mode] in the [GD80 
Compatible] tab window of [Others]

Bar code reader [Read Data] to be enter-
ed in the memory ad-
dress set for [I/F 
Memory] of [Bar Code 
Setting] is “word units.”

Possible
By checking [Output the number of data read by a bar-
code reader by words] in the [GD80 Compatible] tab 
window of [Others]

With check mark : Same display as GD-80.
Without check mark : To be output in byte units.

Model
Item

Message representing 
day of week is registered 
in message edit

Calendar display Possible
Calendar is converted as [Calendar parts] and the mes-
sage in the message edit is automatically copied to and 
registered in the [Week] tab window in the calendar parts.

Character 1/
Character 2

Usage differs between 
Character 1 display and 
Character 2 display.

<Character 1 display>
• 1-byte characters and 
  2-byte characters are 
  distinguished.
• For 1-byte characters, 
  NULL code is process-
  ed as indicated below.

Conversion is made in [Char. Display].
Compatibility to character display on GD-80 is possible 
by checking [JIS/ASCII] of the [Detail] tab window.

<Character 2 display:     JIS/ASCII>
• Unlike GD-80, NULL code is processed as indicated 
  below.

<Character 1 display:     JIS/ASCII>
• In case of [    1-byte]
  Same display as GD-80
  Same NULL code processing

A   CD

   BCD

A

D100 = H0041
D101 = H4443

H 41  00  43 44 H 41  00  43 44

Character-string following “00” is 
not displayed.

H  00  42 43 44 H  00  42 43 44

D100 = H4200
D101 = H4443

Numerical data 
display

In the setting of [Code: 
BCD], display at the GD-
80 is as shown below.
  PLC side   GD-80 side
     0 to 9          0 to 9
         A .
         B :
         C -
         D +
         E          (space)
         F           (space)

Possible
By checking [Num. Data Display: display special charac-
ters instead of A to F when BCD is selected] in the [GD80 
Compatible] tab window of [Others]

With check mark : Same display mode as with GD-80.
Without check mark : “A” - “F” are always displayed in “0.” 

(In LSB --> MSB)

Character-string following “00” is 
not displayed.

CONSIDERATIONS ON SOFTWARE



18

 Data converted as GD-80 compatible data
There are notes on converting GD-80 to V6 in some functions that are possible in V-SFTE before adding

V609E to V6 series line up.

Basically, these functions are automatically converted as GD-80 compatible functions.

GD-80

Read/Write Area

V6

Possible
[Main 1]  tab window of [Comm. Parameter]
Check [Read/Write Area GD-80 Compatible].

Switch/Lamp [Frame type: graphics] [Graphic Call] is automatically set on the screen for 
creating/editing switch/lamp parts.

Model
Item

• Screen with only back-
  ground color
• Screen with only back-
  ground graphics
• Screen with both back-
  ground color and 
  graphics

Background of 
screen

--> Converted as unregistered screen

--> Converted as a screen with a graphic call

--> Converted as a screen with a background color and a 
      graphic call

Overlap • Normal
  No items are registered 
  in a screen except an 
  overlap in DIV0.
• Other items except an 
  overlap are registered 
  in other DIV, or an 
  overlap is not registered 
  in DIV0.

--> An overlap is registered in the same number of a 
     multi-overlap edit as one of a screen in GD-80 auto-
     matically.

--> An overlap is registered as a normal overlap in a 
     screen. And an overlap is also registered in the same 
     number of a multi-overlap edit as one of a screen in 
     GD-80 automatically.
     (Possible in V-SFTE Ver. 1.2.19.0 or later  
      Refer to page 3-7.)

Switch [Switch Memory] of the 
following [Function]:
     [Normal]
     [Block]
     [+/- Block]
     [Mode]
     [Bit Operation] --> Converted to [Output Memory].

Relay mode • DIV0
• DIV1
• DIV2
• DIV3

--> Converted to [Relay Info. Output] as Write Area n+5.
--> Converted to [Relay Info. Output] as Write Area n+8.
--> Converted to [Relay Info. Output] as Write Area n+11.
--> Converted to [Relay Info. Output] as Write Area n+14.

Tenkey mode Entry mode
• The contents of [Command Memory] are the same as 
  that of GD-80.
•  Write Area n+2 is automatically specified for [Info. Out 
   Mem].
•  Charaters in a keypad
   [0] to [9] and [.] are converted to the drawing characters 
   on a screen.
   [0] to [9] and [.] are also stored in [Char. Entry] in the 
   [Switch] dialog in 1-byte character.
   The characters within the switch are placed off the 
   screen so that they do not cover the drawing characters.
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GD-80 V6Model
Item

[Type: Block] • [Type: Block]
• [Target Memory: Output Memory]
• [Input Item Select: Internal]
• [GD80 Compatible] cannot be specified (but checked).
• The settings of tenkey blocks are set in DIV4 as settings for [Data 
  Block Area] mode.

[Data Block Area] mode
· [Division No: 4]
· [Command: Internal]
· [Initial Block/Min. Block: (Set the number of [Start].)]
· [Max. Block: (Set the number of [End].)]
· [Item Select: (unchecked)] (Set if necessary.)
· [GC80 Compatible: (checked)]

[Type: 
Block Direct]

• [Type: Block]
• [Target Memory: Direct]
• [Input Item Select: Internal]
• [GD80 Compatible] cannot be specified (but checked).
• The settings of tenkey blocks are set in DIV4 as settings for [Data 
  Block Area] mode.

[Data Block Area] mode
· [Division No: 4]
· [Command: Internal (same as GD-80)]

· [Item Select: (checked)]

· [GD80 Compatible: (checked)]

[Type: 
Indirect]

• [Type: Data Display]
• [Target Memory: Output Memory]
• [Input Item Select: External]
• [GD80 Compatible: (checked)]
  When there is no overlap, "4" is set.  When there is an overlap, the 
  DIV No. for the overlap of GD-80 is set.
•  For numerical displays on a screen, [Display Function: Entry 
   Target] is set.  The number of [Order] is converted automatically as 
   shown below.

DIV No.
0
1
2
3

Data No.
0 to 31
0 to 31
0 to 31
0 to 31

Order
0 to 31
32 to 63
64 to 95
96 to 127

GD-80 V6

Tenkey mode

[Type: Multi]

[Type: Direct] • [Type: Direct]
• For numerical displays on a screen, [Display Function: No] is set.

* When [Command: External] is set, the address of [Block No. Read Mem.] 
  is the same as of [Command Memory] in [Entry] mode.

* Specify the same number as [Command Memory] n+1 and choose [2] 
  words.

• [Type], [Target Memory], [Input Item Select], [GD80 Compatible] are
  set same as that in case of [Type: Block Direct].
• The settings of tenkey blocks are the same as that of [Data Block 
  Area] mode in case of [Type: Block Direct].

* When [Command: External] is set, the address of [Block No. Read Mem.] 
  is the same as of [Command Memory] in [Entry] mode.  When the overlap 
  containing the keypad is stored in another screen (= multi-overlap is 
  used),  [Block No. Read Mem.] is temporarily set in [$u4000].  Be sure to 
  change it from [$u4000] to the address of [Command Memory].
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GD-80 V6Model
Item

Character Entry 
mode

Entry mode
• [Type: Data Display]
• [Command Memory: (same as [Memory] in GD-80)]
• [Info. Output Mem: (converted to Write Area n+2)]
• [Target Memory: Direct]
• [Input Item Select: Internal]
• [Detail] tab window
     [Use Graphic: (checked)]
     (Both [Start Graphic] and [End Graphic] are automatically set same as 
     [Initial Graphic No.] of [Charater Entry] mode in GD-80.
     If necessary, specify [End Graphic] later.)
• For character displays on a screen, [Display Function: Entry Target] is set.

• The DIV No is converted as follows.

• For [Result Display: checked], the numerical display [Display Function: 
  No] is set in the same DIV No. as that of a statistics graph.  [Memory] of 
  each numerical display is the same as [Memory] of the graph.
• For [% Display: checked], the numerical display [Display Function: Display 
  Statistics Graph %] is set in the same DIV No. as that of a statistics graph.

Statistics graph 
mode DIV No.

Graph No.
V6 DIV No.

0
0   1    2    3
0   10  11  12

1
0   1    2    3
1   20  21  22

2
0   1    2    3
2   30  31  32

3
0   1    2    3
3   40  41  42

GD-80

General-purpose 
serial communi-
cation

V6

General-purpose serial 
communication protocol, 
special to GD-80, is used.

Impossible
Since the general-purpose communication protocol, 
special to V series, is used, the protocol is not compatible.

Overlap
[Type: Multi]

Memory “n”:
Indicates the screen No. 
where the displayed 
overlap is registered.

When the overlap is 
cleared, the screen No. 
entered last remains in 
memory “n.” 

Memory “n”:
The number in the [multi-overlap edit] in which the 
displayed overlap is registered.

When the overlap is cleared “-1” (= HFFFF) is set in 
memory “n.” 

Model
Item

Baud rate
1200 and 2400 bps are 
available.

Communication 
parameter

Impossible
Both baud rates are automatically converted to 4800 bps.

Display characters Characters to be display-
ed are not influenced by 
“Enlarge X/Y” setting.

When an even value is set for “Enlarge X/Y,” such 
characters are automatically displayed in 32-dot font.  
Accordingly, displayed image will somewhat differs from 
the characters displayed at GD-80.

Character-string of 
switch/memory

Character-strings are 
created in graphics.

Character-strings are converted as graphics.
They are not converted as character-strings in the 
[Switch] (or [Lamp]) dialog.

 Incompatible Functions after Conversion

There are functions for which compatibility with GD-80 cannot be maintained after converting to V6.

The following describes these functions
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GD-80 V6Model
Item

Trend graph Control Memory
Memory “n” specified by 
each [0 to 15 tab 
windows]  (“n” exists by 
the number of display 
counts)

Graph value memory
Memory “n” (specified by 
each [0 to 15 tab 
windows]) + 1

Control Memory
Only “memory n” specified by No. 0 of graph at GD-80
(All graph broken lines are controlled by memory “n”)

Graph value memory
Memory “n” (specified by each [0 to 15 tab windows]) + 1

Numeric key mode
[Type: Direct 
Command]

Memory “n”:
Clear (bit 15)

The write flag and dis-
played value of numeric 
data entry are cleared at 
the timing this bit is 
turned ON (0 --> 1).

Input mode [Command Memory]: n
Clear (bit 15)

When this bit is turned ON, the write flag is cleared, and 
the display of entered data itself is also cleared.
Entry is enabled when data type and the digit number, 
etc. are designated after turning OFF the clear bit (bit 15).

Memory “n” = H0084 
(DEC/4-digit designation)

Memory “n” = H8084
(Clear: DEC/4-digit designation)

0 5130

0

Memory “n” = H0084 (DEC/4-digit designation) --> Entry of numeric data

Memory “n” = H8084 (Clear and type designation) --> Memory “n” = H0084

0 5130

0

Numeric key mode
[Type: Block Entry]

Memory “n”:
Clear (bit 15)

After the entry of numeric 
data using the numeric 
keypad, the keys are 
completely disabled.
At the leading edge (0 
--> 1) of bit 15, the write 
flag using the numeric 
keypad is cleared and 
the keypad disabled state 
is canceled.

Input mode [Command Memory]: n
Clear (bit 15)

After the entry of numeric data using the numeric keypad, 
entry for the same data item is not allowed.  However, 
since the clear (CL) key is valid, the numeric keypad is 
enabled by pressing the clear key.
In addition, since the [UP] and [DW] keys are always 
valid, entry using the numeric keypad is accepted after 
moving the cursor to the next data entry objective data 
item.
To enter the data for the same data item continuously, 
this bit is valid

Entered value

0.0

0.00

0

0 7 8 9

4 5 6

1 2 3 CLR

0 . +/- ENT

5130

All switches are disabled.
(until the clear bit is set ON.)

Entered value

0.0

0.00

0

0 7 8 9

4 5 6

1 2 3 CLR

0 . +/- ENT

5130

Only these keys are valid.

Sampling
(Bit / Data / Trend)

During scrolling in the 
sampling data area using 
the [Roll Up]/[Roll Down]
/[Plus Block]/[Minus 
Block] switch, nothing is 
displayed in the display 
area.

During scrolling in the sampling data area using the [Roll 
Up]/[Roll Down]/[Plus Block]/[Minus Block] switch, the 
cursor is displayed and the data currently selected can be 
recognized.

Entry of 
numeric data

* It is not possible to gain the totally identical control as GD-80.
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GD-80 V6Model
Item

Sampling
(Trend)

Count value is displayed 
only at V6.

Count of the zero position 
is displayed at the lower 
left area of the graph.

Numeric values [Display Function: Sample Count Display], 
[Digits: 3] and [Char. Type: 1/4] are set at the lower left 
area of the graph.

The current count is displayed.

Sampling
(bit)

A space of 1-byte chara-
cter size is provided 
between the display in the 
area and the message.

A space of four 1-byte character size is provided between 
the display in the area and the message.

Memory card 
mode

Card No.
/Card name
/File name
/Record name edit
  Edited and entered No./
  name are once stored in 
  the PLC memory.

Card No.
/Card name
/File name
/Record name edit
  Impossible
  Since No./name is directly written in the memory card, 
  nothing is stored in the PLC memory.

Switch [Action]
• [File Select]
• [Record Select]
• [Selection Complete]

To select a file/record in 
the card, follow either of 
the procedures below.
[File Select] -> (1) 
[Selection Complete] -> 
(2) [Selection Complete], 
or [Record Select] -> 
[Selection Complete]

Switch [Function]
-> [File Select]
-> [Record Select]
-> (None)

To select a file/record in the card, follow either of the 
procedures below.
[File Select] -> (1)(2) (Press the display area)
[File Select] -> [Record Select] -> (Press the display area)

The operation “press the display area” is used instead of 
pressing the [Selection Complete] at GD-80.

Card No.  0 File No.

Card Name  Hak File Name

File No.  3

File Name  TU-008

File Select

Rec Select

Card No.  0

Card Name  Hak

File Select

Rec Select

Sel Finish

0. Produce
1. Target
2. SR-003
3. TU-008

Sel Finish

0. TUA
1. TUB
2. TUC
3. TUD
4. TUE
5. TUF
6. TUG

Card No.  0 File No.

Card Name  Hak File Name

0. Produce
1. Target
2. SR-003
3. TU-008

0. TUA
1. TUB
2. TUC
3. TUD
4. TUE
5. TUF
6. TUG

File No.  3

File Name  TU-008

File Select

Rec Select

Card No.  0

Card Name  Hak

File Select

Rec Select

Switch [Action]
• [File Name Edit]
• [Record Name Edit]

Press [File Name Edit] or 
[Record Name Edit] after 
selecting a file or a re-
cord, and the multi-over-
lap for which the chara-
cter entry mode is set is 
displayed.

Switch [Function]
-> [File Name Edit]
-> [Record Name Edit]

Select a file or a record after turning ON the [File Name 
Edit] or [Record Name Edit] switch, and the multi-overlap 
for which the entry mode is set is displayed.

Record Select

0. Produce
1. Target
2. SR-003

Rec Name Edit

B C DA

F G HE

0. TUA
1. TUB
2. TUC

Record Name          TUARecord Select

Rec Name Edit

Blinking
Record No.  0

Record Name  TUA

0. TUA
1. TUB
2. TUC
3. TUD
4. TUE
5. TUF
6. TUG

File Name Edit

Rec Name Edit

Record No.  0

Record Name  TUA

0. TUA
1. TUB
2. TUC
3. TUD
4. TUE
5. TUF
6. TUG

File Name Edit

Rec Name Edit

B C DA

F G HE

Record Name          TUA

CR CR
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GD-80 V6Model
Item

Editing No./name 
in the memory 
card mode

• Multi-overlap is always 
  used.
• Editing is impossible 
  unless [Memory] bit 12 
  of the numeric keypad 
  entry mode/character 
  entry mode for No./
  editing is set ON.
• An overlap is deleted 
  when the [ENT] key is 
  pressed and the card 
  No. or the card name
  /file name/record name 
  is entered

In the state after conversion, converted data cannot be 
used as it is.

Take the following into consideration.
1)  In the state the normal overlap for [Type: Multi] is reg-
     istered in the screen, the overlap is transferred to the 
     same area of the screen No. of [multi-overlap edit].
2)  The entry mode on the overlap is always changed to 
     [Type: Memory Card].
3)  [Num. Display] parts or [Char. Display] parts of 
     [Display Function: Entry display] are always set in the 
     same DIV as the entry mode on the overlap.
4)  If [Data Block Area] is set on the overlap, it is deleted 
     since it is unnecessary.
5)  Name display parts are automatically converted in 
     [Bytes: 3].  Therefore, setting should be changed if 
     necessary.

The memory card mode operates normally by the setting 
indicated above.

* [Command Memory] operation in the [Entry] mode is 
  not necessary.

Record No.   1

Record Name ABC

File Select File Name Edit

Record Select Rec Name Edit

File No.         1

File Name     ABC

B C DA

F G HE

Record Name          ABC

For the screen on GD-80, where nothing is registered 
other than the normal overlap.

Screen No. 20 (GD-80)

B C DA

F G HE

Record Name          ABC

At V6, the normal overlap is automatically reg-
istered in the same number as multi-overlap edit.

Multi-overlap edit No. 20 (V6)

Entry mode
[Type: Data Display (or Block)]

[Type: Memory Card]

2)

1)

3)

5) For checking [Bytes]

Screen No. 19 (V6)

Display function: Entry Target

Display Function: Entry Display

Line Among the eight kinds of 
lines, four kinds of lines 
can be edited as needed.

Impossible
Six line kinds are provided in total and all of them are 
fixed.

CR

CR
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V4 Series -> V6 Series

 Converting the Screen Data Files

For the conversion of the screen data files into the V6 series compatible

files, always use V-SFTE.

1. Open the V4 screen data file that you want to convert.

2. Go to the [Edit] menu and select [System Setting].

3. Click on [Edit Model Selection]. The [Edit Model] dialog is displayed.

4. Select the model to be used after conversion and click [OK].  The editor displays the screen data converted

for V6 series.

CONSIDERATIONS ON SOFTWARE



25

 Difference in screen size

When converting the screen data file from V4 series to V6 series, there are no differences in resolution as

shown in the table below.

V610
640 x 480

V608
640 x 480

V606/606i
320 x 240

Model

Resolution W x H

(Dots)

V4 640 x 480

V4S 320 x 240

V609E
640 x 400

No. 1

V4 V6

Switch
[Action: ICON2]

Provided Not provided
[Action: ICON2] is automatically converted into 
[Action: ICON1].

Model
Item

Overlap Max. size
741,376 bytes

Switch output [Analog switch type]
Touching two points at the screen is disabled.  
Touching the function switch while touching the screen 
is permitted.
[Matrix switch type]
Setting of [1 Output]/[2 Output] is possible at each screen.

Switch 
arrangement
(Arranging 2 
switches)

The switch arranged
 later is active.

<Previous>
The switch arranged first is active.

<1.2.19.0>
To restore the same response as available with V4, 
select [    Make the upward switch effective when switches 
are overlapped] in the [GD-80 Compatible] tab window 
called by touching [Others].

No. 0

No. 1

If you touch here
No. 0

No. 1

No. 1 is active.

No. 0

No. 0 is active.

Data display No data is displayed if overflow occurs.

Example) D100 = 1234
4-digit display: 1234
2-digit display: --

[V610T/C]
Max. screen size: 307,200 bytes
Max. overlap size: 921,600 bytes

[V608C]
Max. screen size: 307,200 bytes
Max. overlap size:

Area 1:  368,640 bytes
Area 2:  307,200 bytes
Total:  675,840 bytes

If error message "Data has some error. No. 54" 
is displayed at V6, reduce the overlap size.

Setting of [1 Output]/[2 
Output] is possible at 
each screen.

If overflow occurs, upper 
digits are displayed.

Example) D100 = 1234
4-digit display: 1234
2-digit display: 12
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